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Welcome
Welcome to QuickBooks. Whether you’ve been running your business for years or are just 
starting out, having an organized, efficient way to manage your business can save you time, 
money, and a lot of frustration. Use this QuickBooks Basics guide to learn key tasks and get up 
and running as fast as possible.

Note: Since this guide covers multiple editions of QuickBooks, the name “QuickBooks” is used to refer to any of 
these editions. When information in this guide applies to a specific edition of QuickBooks, the specific edition 
name will be used.

What’s in this guide?
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Getting Around QuickBooks1

The QuickBooks work area, shown in Figure 1, is designed to enable you to complete tasks 
quickly. QuickBooks provides several ways for you to work; choose the method that works best 
for you.

Figure 1. The QuickBooks work area

Using the Home page to move around in QuickBooks
When you open a company file in QuickBooks, the Home page is displayed automatically. 
The QuickBooks Home page provides a big picture of how all your essential business tasks fit 
together. Tasks are organized into logical categories (Customers, Vendors, Employees, Company, 
and Banking) with workflow arrows to help you learn how tasks relate to each other and to help 
you decide what to do next.

Note: The workflow arrows indicate a logical progression of business tasks in QuickBooks. However, these 
arrows do not restrict you from doing tasks in a different order, or an order that works better for your business 
needs.

To start a task, simply click the icon for the task you want to do. For example, to create an 
invoice, click the Invoices icon.

To return to the Home page, click the Home button on the icon bar.

1. Screenshots in this section are for illustrative purposes only, and vary among versions of QuickBooks.

The Home page offers quick access to tasks 
and information related to major QuickBooks 
areas.

The customizable icon bar 
on the toolbar provides one-
click access to the QuickBooks
features that you use most.

The menu bar provides 
easy access to all 
QuickBooks tasks, features, 
and reporting functions.

Flow chart icons include
informative tooltips to help you
learn QuickBooks and pick the
correct task.

Refer to the in-product 
Help for detailed instructions 
about how to perform tasks 
in QuickBooks.

Get answers and advice from 
users and experts from the
QuickBooks Live Community.

The QuickBooks Coach guides
you through the steps in your
business workflows.

With coach tips on, spotlights 
show you the steps in your 
workflows, and tips display 
when you mouse over the 
spotlighted form icons. 
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The Home page also provides a quick glance about the state 
of your business. You can see your current account balances, 
updated automatically as you do work in QuickBooks, in the 
Account Balances list.  

The Home page you see has been customized to display only 
those tasks and features that you use, based on the questions 
you answer in the EasyStep Interview. Functions you don’t 
need won’t clutter your workspace. However, to add these 
functions later, you can turn them on in preferences. Go to 
the Edit menu and click Preferences. Click the Desktop View 
option and then click the Company Preferences tab.

If you’re a new business owner or new to QuickBooks, the 
QuickBooks Coach will walk you through the business flows 
you see on your Home page. The QuickBooks Coach uses 
spotlights and tips to explain each step in your workflow. Turn 
coach tips on and then mouse over and click the Coach icons 
( ) to see tips and spotlights.

Getting a real-time view of your business
With the Company Snapshot, QuickBooks provides you quick 
access to a real-time view of your business on one page, 
including a trend graph of your income and expenses, your 
account balances, customers who owe you money, vendors 
you need to pay. The company snapshot is also fully 
customizable. You can add, remove and move data around to 
make it right for your business. To open the Company 
Snapshot go to the Company menu and click Company 
Snapshot.

Figure 2. The Company Snapshot gives you a real-time 
view of your business

Customizing the desktop
You can modify the way the 
QuickBooks desktop behaves 
and looks to suit your 
working style. To modify the 
QuickBooks desktop, choose 
the Edit menu and choose 
Preferences.

Customizing the icon bar
You can add, rearrange, and 
remove shortcuts from the 
icon bar to suit your needs. 
To modify the icon bar, go 
to the View menu and then 
click the Customize Icon Bar.

Too many windows open?
If your QuickBooks work 
area becomes too cluttered 
with windows that you have 
open, you can close them all 
at once instead of closing 
them one at a time. To close 
all open windows, go to the 
Window menu and click 
Close All.

Using the sample company 
files
QuickBooks includes 
several sample company 
files that you can practice 
with to enter pretend data, 
run reports, and explore 
QuickBooks features.

To open a sample company 
file, choose the File menu, 
choose Open or Restore 
Company, and then select 
a sample company file from 
the list.
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Finding your data in the QuickBooks Centers
QuickBooks includes Customer, Vendor, and Employee Centers where you can view and manage 
all of your customer, vendor, and employee information and transactions. You can go to one of 
the QuickBooks Centers by clicking the appropriate button in the icon bar (on the left side of the 
toolbar).

Customer Center
The Customer Center, shown in Figure 3, is a lens into all your customer information. Without 
having to sift through multiple screens, you can view a list of all your customers and see 
pertinent information for each of them. Click on a customer’s name and you’ll immediately 
see all the activity you’ve had with them as well as their pertinent contact information (phone 
number, fax number, and payment terms). 

You can use the Customer Center to find out how much money a specific customer owes you or 
to view a list of all your customers with open balances. You can also look at all your customer 
transactions (estimates, sales orders, invoices, credit memos, refunds, etc.) across all of your 
customer in the Transactions list rather than having to run separate reports.

Easily access your customer’s
contact information and any
notes on that customer.

Click a customer in the 
Customers & Jobs list to view
useful data.

View all of your past trans- 
actions with this customer,
or filter this list to display only
one type of transaction, like
overdue invoices.

 

Run quick reports that pertain
to this customer.

Use the Transactions tab to
find, sort, and filter all your 
transactions across all of 
your customers.

Easily add customers and jobs.
Create new transactions
(estimates, invoices, sales
orders). 

Figure 3. View and manage customers, vendors, and employees with the QuickBooks 
Centers



7

Learning QuickBooks

Vendor Center
The Vendor Center gives you a complete picture of where your money is going. From one screen, 
you can see all your vendors and exactly what you owe them. Simply click a vendor’s name to 
view your entire history with that vendor. You no longer need to run separate reports to see 
exactly how much business you’re doing with each individual vendor. And, you can sort your 
bills by due date so you can stay on top of your finances. 

If you need to talk to a vendor, click the vendor’s name and you’ll see all their contact 
information. If a vendor calls you to follow up on a late payment, you can quickly look up the 
bill and see when you paid it and what the check number was. 

Employee Center
From the Employee Center, you can see exactly what you’re paying each employee. Simply click 
an employee’s name to view that person’s payroll history. And if you need to get in touch with 
an employee, their contact information is right in front of you.

Payroll Center
If you subscribe to one of the QuickBooks Payroll services (additional fees apply), the Employee 
Center includes a Payroll Center. Use the Payroll Center to manage your payroll and payroll 
compliance.2

The Payroll Center is the hub for managing all payroll activities. The Payroll Center reminds you 
of important payroll dates so you pay your employees, pay your payroll liabilities, and file forms 
on time.

To check out the Payroll Center, click the Employee Center icon on the icon bar and then click 
the Payroll tab.

Displaying multiple windows or one window
QuickBooks is preset to show multiple windows at a time. By doing so, you can easily navigate 
between tasks as well as compare data in multiple windows. When you open a window, it opens 
to a preset size and location. You can resize and move each window as you see fit.

Depending on how you size or arrange the windows, some windows might not be visible. Use 
the Window menu to view a list of the open windows. Simply click the window name in the list 
to bring it to the front.

Alternatively, you can open the Open Window List to have the list of open windows always visible 
on the left side of the QuickBooks application window. If you prefer to view only one window at a 
time, go to the View menu and click One Window.

2.  QuickBooks Payroll Services require subscription, Employer Identification Number (EIN), and Internet ac-
cess for certain features, including tax table updates and direct deposit.
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Adding icons to the icon bar
For quick access to the areas of QuickBooks you use most, you can customize the icon bar by 
adding many of the features and reports that you use most frequently.

 

To add a shortcut to a QuickBooks
window, open the window and then
go to the View menu and click
the Add to Icon Bar option.

You can add, rearrange, or remove
shortcuts from the icon bar in the
Customize Icon Bar window.

Note: Some QuickBooks windows cannot be added to the icon bar.

Key QuickBooks Concepts
To take full advantage of QuickBooks, there are some important concepts you need to 
understand.

How to work with QuickBooks lists
Lists are one of the important building blocks that make QuickBooks so powerful and efficient. 
QuickBooks uses list information to fill out most QuickBooks forms. For example, to create an 
invoice, you choose the customer name from your Customers & Jobs list.  
 
QuickBooks automatically enters the customer information on the form for you. This saves you 
time and prevents typing errors. You can also change the information directly on the form as 
needed. Lists are easy to set up in QuickBooks, but do require careful planning.

Depending on the type of list you want to use, you can get to the list in one of two ways:

• QuickBooks Centers: Your Customers & Jobs, Vendors, and Employees lists are available in 
the Customer, Vendor, and Employee Center, respectively. Click the appropriate QuickBooks 
Center button on the icon bar to go to a QuickBooks Center.

• List windows: Other lists, such as the Chart of Accounts and Item List, appear in separate 
windows. To view one of these lists, click the Lists menu and then click the list you want. To enter 
information in these lists, use the menu button at the bottom of the list to add, edit, or delete list 
items. The menu also provides access to common features associated with the list.

      

The more detail you enter for each list item, the more information QuickBooks can use to pre-
populate forms, track financial data, and display useful reports about your business. Another 
advantage of lists is that common tasks like adding list entries, editing list information, and 
deleting list entries are performed the same way.
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Figure 4 illustrates how QuickBooks uses list information across multiple windows and tasks to 
simplify data entry and to give you a complete picture of how your business is doing.

1

2

4

2. Enter customer information in the
    New Customer window.

4. Pick a customer name 
    from the list and choose
    to create an invoice from
    the New Transactions 
    menu. The customer 
    information is entered
    automatically.

5. All invoices for this customer are listed in the
    Transaction Details area.

6. To view a list of invoices for all your customers, 
    use the Transactions tab.

3. The information for the new
    customer appears in the
    Customers & Jobs list.

1. Use the Customer Center to view customer data.
    Click New Customer & Job to add a customer
    to your list.

65

3

Figure 4. How QuickBooks reuses list information to make your life easier
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Entering list information as you work
There are two basic methods you can use to enter list information in QuickBooks. You can enter 
account, customer, vendor, product, and service information before you enter transactions in 
QuickBooks, or you can enter this information “on the fly” as you use the product.

If you prefer to enter information as you use QuickBooks to perform your daily tasks, QuickBooks 
prompts you to immediately set up any entry it does not know about. For example, if you try to 
create an invoice for a customer named John Dowden and you have not entered information 
about John Dowden into QuickBooks, QuickBooks will prompt you:

Clicking Quick Add creates a new customer list entry for John Dowden in the Customers & 
Jobs list and adds all the information you enter about the customer on the invoice form (billing 
address, payment terms, taxable status).

Clicking Set Up takes you to another window where you can enter information not covered by 
the invoice. For example, you could click Set Up to enter John Dowden’s phone number, fax 
number, and credit limit.

Add/edit multiple list entries
You can also enter lists of customers, vendors, and items using the Add/Edit Multiple List Entries 
window.  

Steps at the top of the page guide you through the process; you can also watch the tutorial to 
see how to add multiple list items.
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To add multiple list entries:

➊ From the menu bar, choose Lists > Add/Edit Multiple 
List Entries to open the Add/Edit Multiple List Entries 
window. 

❷ Click the List drop-down arrow and select the list you want 
to work with.

❸ If you already have records in your list, you can filter it to 
see a particular record or set of records.

❹ Optionally, choose which columns you want to see in 
the Add/Edit Multiple List Entries window by clicking 
Customize Columns. (This helps you focus on just the 
columns you want to work on.)

❺ Add or edit entries in the list.

❻ Click Save Changes.

Refer to the in-product Help for information on adding and 
editing multiple customers, vendors, and items to your lists.

Writing checks versus paying bills
In QuickBooks, you can manage your bills and payments in two 
ways:

Write checks to pay bills now. Use the Write Checks 
window and assign the amounts to appropriate expense 
accounts. This method is recommended when you don’t 
receive a bill, such as when you go to the store and write 
a check and then you need to record that expense in 
QuickBooks. You can also use Write Checks to pay a bill as 
soon as you receive it, as long as you don’t need to track 
the bill.

Enter bills when you receive them and pay them later. 
Use the Enter Bills window to enter bills when you receive 
them. Then use the Pay Bills window to pay bills when 
they are due. You can set up QuickBooks to remind you 
to pay bills when they are due.  Using this method, you 
keep your money in your business for as long as possible. 
You might still use a check to pay the bill, but this method 
enables you to track how much money you owe. And at 
any time, you can run reports to analyze unpaid bills for 
information such as which vendors you owe money.

Note: Do not simply write a check in the Write Checks window to 
pay bills that you entered in the Enter Bills window or the accounts 
payable registers.

What happens when I 
record a bill payment?
If you paid by:

• Check. QuickBooks 
prepares one check for 
each vendor and records 
the checks in the check 
register with BILLPMT in 
the Type field.

• Credit card. QuickBooks 
records a charge for each 
vendor in your credit card 
register.

• Cash. QuickBooks records 
a payment for each 
vendor in your cash 
account register.

In each scenario, 
QuickBooks records the 
payment to each vendor 
in the accounts payable 
register. The amount you 
paid appears in the Payment 
column.
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Figure 5 below  illustrates the difference between writing checks versus entering and paying bills.

Write checks now
Enter bills now,
pay when due

Receive bill from vendor

Your CompanyCustomer:

Amount Due

Bill Due

BILL                                          Payment Due to Gallion Masonry

Date 07/14/2004

08/13/2004

1,550.00

Pay Vendor

Print checks or make
an online payment

Pay Bills

Enter BillsWrite Checks

1234 Garcia Ave.
Mountain View, CA 94043

Address:

Figure 5.  Writing checks versus entering and paying bills
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Getting Answers to Your Questions
QuickBooks provides a variety of tools and resources to help you find answers to questions you 
might have when using the software Available resources include:

Free help and support
• QuickBooks Learning Center3: The QuickBooks Learning Center provides a set of interactive 

tutorials you can use to learn about basic QuickBooks concepts and common tasks. Go to the 
Help menu and click Learning Center Tutorials. 

• In-product Help: QuickBooks in-product Help provides context-sensitive Help as you are 
using the product. Keep the Help window open. As you use QuickBooks, the Relevant Topics 
section will automatically update to provide you with one-click access to Help on the most 
common questions for the QuickBooks window you are using. Go to the Help menu and click 
QuickBooks Help, or just click F1.

• QuickBooks Live Community2: We know that you have needs and questions that are specific 
to your business. Now you can ask other QuickBooks users and experts for help and get 
answers fast, right inside QuickBooks. With Live Community, you can ask your questions 
without stopping the work you’re doing. 

 Not sure how to do something in QuickBooks? Need advice on how to set up a webstore? 
Need a tax question answered? Ask the Community. QuickBooks will even let you know when 
someone has answered your question so you don’t have to keep remembering to check back. 
Go to the Help menu and click Live Community.

• QuickBooks Knowledgebase: Find the most recent information in our online  QuickBooks 
Support Knowledgebase at www.quickbooks.com/support.

• Installation, upgrade and error message assistance is available free for 12 months after initial 
registration for questions submitted online. For more information, visit  
www.quickbooks.com/customercare.4

3. Internet access required for online services.
4.  See details and terms and conditions of Installation, Upgrade, and Error Message Assistance at   

www.quickbooks.com/customercare. Questions must be submitted online at www.quickbooks.com/support 
to receive free support.

www.quickbooks.com/support
www.quickbooks.com/customercare
www.quickbooks.com/customercare
www.quickbooks.com/support
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Paid support
• QuickBooks Support Plans: Get expert, personalized assistance when you need it and 

protection for your valuable financial data. Plans include 24/7 coverage for an unlimited 
number of “how to” questions and technical issues, Online Backup and Data Recovery 
services, and more.5 To learn about Support Plans, visit www.quickbooks.com/supportplaninfo. 
Fees apply. Technical support is also available on a per-call basis for a fee (One-Time Support). 
Go to www.quickbooks.com/contactsupport to learn more.

• Use a local Certified QuickBooks ProAdvisor® (see page 18 for details).

• Find the ideal training solution (fees apply) to help you learn and customize QuickBooks for 
your business at www.quickbooks.com/training.

Using in-product Help
QuickBooks in-product Help provides background information and instructions for doing 
QuickBooks tasks. You can access the Help content and features in several ways.

To use in-product Help, go to the Help menu and click QuickBooks Help.

5.  Hours exclude occasional downtime due to system and server maintenance, company events, observed 
U.S. holidays and events beyond our control. Additional terms and conditions apply. Go to www.quickbooks.
com/supportplaninfo for details.
Terms, conditions, pricing, features, service, and support options are subject to change at any time without 
notice.

In the Search tab, enter a 
description of the help you 
want, and click the search 
arrow.  

When you open Help, the 
Help Viewer displays to the 
right of the QuickBooks window.

Links to topics that are 
relevant to the currently 
displayed window are listed 
in the Relevant Topics tab.

Click any relevant topic 
link to view the Help topic.

Use the Forward or Back
buttons to see topics you’ve
already viewed. Click Print 
Topic if you prefer to have 
a paper copy.

Let us know if the help topic
answered your question and
what we can do to improve
Help.

 

www.quickbooks.com/supportplaninfo
www.quickbooks.com/contactsupport
www.quickbooks.com/training
www.quickbooks.com/supportplaninfo
www.quickbooks.com/supportplaninfo
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Viewing Help for a window you have open
If you are unsure how to use a particular QuickBooks window, press F1. (You can also click the 
Help button in the window, if one is present.) 

These Help topics provide answers to questions such as:

• What can I use this form for?

• What does this button do?

• What kind of information is displayed in this column?

• What happens when I select this option?

• How do I complete the task? 

Information you’ll find in the Relevant Topics tab
Each time you open a new QuickBooks window, the links in the Relevant Topics tab change so 
that they apply to the active window. 

Relevant Help topics will explain how to use the window, and can include:

• Tutorials that show you how to complete tasks  

• Business process overviews   

• Step-by-step instructions  

• Planning and best practice suggestions

• Troubleshooting information

If you don’t see the information you need in the Relevant Topics tab, try using the Search tab 
to find the topic.

Using Help Search to find information 
QuickBooks in-product Help is quite extensive. If you don’t see your issue in the Relevant Topics 
list, you can use Search to find answers to your questions quickly:

• Click the Search tab.

• In the Search field, type a short phrase (containing a noun and verb) that describes the 
information you want. For example, “add a customer” or “How do I add a customer?”

• Click the search arrow. Search will return a maximum of 15 topics based on the words you 
entered. (If you don’t see the information you want, follow the tips below for using search 
effectively.)
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Tip: Using Search Effectively

• Be as specific as possible. 
For example, if you want to know how to add a customer, entering just “customer” will 
return topics ranging from adding a customer to deleting a customer to the Customers 
list and more. Instead, enter “add customer” or “How do I add a new customer.” 

• Enter a shorter search phrase or question. 
For example, “How do I add customers” will return better results than “How do I add 
new customers and vendors.” 

• Try using different words and phrases. 
For example, if you’re looking for something about installing a QuickBooks update, try 
entering “update QuickBooks.” 

• Don’t use abbreviations—use the full word instead.

If you still can‘t find the answer in the topics returned by search, try the Additional 
Self-Help Tools.

Check out the QuickBooks Learning Center
As you begin using QuickBooks, one of the first things you’ll see is the QuickBooks Learning 
Center.6 After you view the Coach Tutorial, you’ll be in the Learning Center. The Learning Center 
provides interactive tutorials to help you learn how to use QuickBooks and complete common 
business tasks. After you complete a tutorial, a checkmark is displayed next to its title. After 
watching the video tutorials, you can follow the step-by-step instructions available in the in-
product Help.

To open the QuickBooks Learning Center, go to the Help menu and click Learning Center 
Tutorials or click the tutorial button in the QuickBooks Coach.

6.  Internet access required to view tutorials.
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Using Live Community 
QuickBooks Live Community lets you ask other QuickBooks users and experts for help and get 
answers fast, right inside QuickBooks. In Live Community, you can ask any question, from how-
to questions about QuickBooks to advice on how to run and grow your business. To use Live 
Community, choose the Help menu and choose Live Community.

Enter your question here and 
click Ask My Question. You’ll 
be notified in QuickBooks when 
someone answers your question.

Previously asked questions that 
have been answered by users are 
displayed here.

Questions that have yet to receive 
answers from the community 
appear here. Do you know the 
answer? If so, click the link to post 
an answer.

Using the QuickBooks Coach
You can explore the Home page with the QuickBooks Coach to learn more about your business 
workflows. In the QuickBooks Coach window, click Start Working to turn explore mode on. Then 
mouse over and click the Coach icons ( ) to see:

• Details about your workflows

• Spotlights that show you the steps in a flow, with tips to complete each step

• Bold numbers, highlighted lines, and arrows show you the order in which to do your work
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Working with a Certified QuickBooks ProAdvisor 
Want hands-on help setting up or customizing QuickBooks for your business?  
You’ll get the most out of QuickBooks by working with a Certified QuickBooks 
ProAdvisor. ProAdvisors are QuickBooks experts who can help you get the most out 
of QuickBooks by customizing the software based on your unique business needs. 
Certified QuickBooks ProAdvisors are typically CPAs, bookkeepers, small business 
advisors, QuickBooks consultants or accountants. They’ve been tested and certified 
in QuickBooks by Intuit.  

• ProAdvisors can help save you time and money by getting your QuickBooks set up right the 
first time to avoid fixing mistakes down the road. 

• ProAdvisors can set up customized reports so you can easily understand the health of your 
business. 

• They also offer ongoing support and training to help you master QuickBooks. 

Visit www.findaproadvisor.com/go to learn more and to find a Certified QuickBooks ProAdvisor 
near you.

www.findaproadvisor.com/go
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QuickBooks Essential Tasks1

Learning how to do essential QuickBooks tasks
The table to the right lists the essential tasks that most people use to run their company in 
QuickBooks. This chapter describes how to perform each of these tasks and offers important 
usage tips.

The tasks are written assuming that you want to set up all the information for your business 
(for example, customer, vendor, and account information) before you begin creating invoices, 
receiving payments, or paying your bills.

However, you might prefer to enter information as you need it. For example, you might create 
an invoice for a new customer and use Quick Add (described on page 10) to enter the customer 
information “on the fly.” Either method works fine. You choose the method that works best for 
you.

1. Screenshots in this section are for illustrative purposes only, and vary among versions of QuickBooks.
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Setting Up Your Business

Preferences: Changing QuickBooks to work the way you do page 22

Adding an account page 24

Adding customers page 28

Adding vendors page 30

Adding items page 32

Setting up sales tax page 36

Setting up your payroll page 44

Setting up employees page 48

Money In

Creating an estimate page 50

Creating an invoice page 52

Entering sales receipts page 54

Receiving a payment page 56

Making a deposit page 58

Money Out

Paying bills page 60

Writing checks page 62

Issuing credits and refunds page 64

Paying employees page 66

Managing Your Business

Using reports page 68

Additional services and resources page 72
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Setting Up Your Business  |  Preferences

Preferences: Modify QuickBooks for the way you work

Set personal and company
preferences for each 
QuickBooks area.

Choose a group from the 
preference list to set 
behavior for other 
QuickBooks areas.

3

Click General to set
general QuickBooks 
preferences.

2
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Setting Up Your Business

Changing QuickBooks to work the way  
you do
You can modify QuickBooks in many ways to suit the needs 
of your business and your personal style of working. From the 
QuickBooks Preferences window, you can define preferences 
in over a dozen different categories.

For example, you can configure general preferences such as 
whether or not QuickBooks prompts you before editing or 
deleting a transaction, or which date QuickBooks uses for 
new transactions. Or, you can configure accounting-specific 
preferences such as how QuickBooks displays accounts and 
subaccounts.

To view and set preference options:

➊ Choose the Edit menu and choose Preferences. 

➋ In the Preferences window, change any of the general 
QuickBooks preferences. These preferences determine how 
QuickBooks behaves.

➌ To display the preferences for another area of QuickBooks, 
select the appropriate category in the list on the left. For 
example, to set preferences for reporting functions, select 
Reports & Graphs. 

➍ On the My Preferences tab for the particular feature area, 
enter the changes and settings you want. These settings 
affect only your QuickBooks sessions, not those of other 
users.

➎ Do one of the following: 

• Click OK to close the Preferences window and save your 
changes. 

• Click another feature area in the scroll box to enter 
other preferences. Click Yes when prompted to save 
your changes.

➏	 Click OK.

Company preferences
Company preferences are 
global preferences that 
affect all users of the 
company file. Only the 
QuickBooks Administrator 
can set up or modify 
company preferences.

My Preferences
You can customize your 
workflow by setting personal 
QuickBooks preferences, 
such as using the Enter key 
instead of the Tab key to 
move between fields.
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Customize Forms: Where to start

A. Click a business form on 
the Home page and then
click Get Started.

B. Once you’ve opened a 
business form on the Home 
page, click Customize.

Click Create New Design 
or Customize Data Layout, 
depending on whether you 
want to customize a 
template or customize the 
layout of the data. 

C. In the menu bar, click
Lists > Templates.

Click the Templates button  
and then click Create Form 
Design.
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Promote your business with a  
consistent, professional look
You can quickly customize all of your QuickBooks forms to give 
them a consistent, professional look so they get noticed by your 
customers. Customize your business forms from any of these 
access points:

A. Click a form icon on the Home page and then click Get 
Started in the Customize window.

B. Once you open a form, you can choose to customize its 
look and feel, or customize the way the data is laid out on 
the page. 

 Click Customize at the top of the form and then click 
Create New Design. In four simple steps you can design 
the look of your forms:

     

 After you complete each step, click Next. When you finish, 
select the forms to which you want to apply your new look 
and click Apply.

 

 QuickBooks makes a copy of your original form and 
applies the design on the new copy. You can find your new 
forms in the Templates list on each form window — they 
all start with the prefix “My Design.”

 OR

 Click Customize Data Layout and customize the header, 
columns, footer, and other data layout properties.  

C. In the menu bar, choose Lists > Templates. Click the 
Templates drop-down list and select Create Forms Design 
to open the online customization tool.

Customizing forms
QuickBooks now includes 
a variety of colorful, 
professionally designed 
forms backgrounds that you 
can add to all your forms.

The new online 
customization tool guides 
you through 4 simple steps 
to create and save your 
designs. And it saves you 
time because you can apply 
changes to all of your forms 
at once, instead of needing 
to customize one form at 
a time.

It’s easy to customize forms, 
because all your changes 
to the background, logo, 
fonts, colors and grid style 
(borders, shading) are 
updated in the preview so 
you can see exactly how 
your forms will look after 
you apply the finished 
design.

For more information about 
customizing business forms, 
refer to the in-product Help.
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Chart of Accounts

Add New Account

QuickBooks supports 16 
different types of accounts.

Click here to make the
account a subaccount of 
another account.

Click here to enter an
opening balance for the
account (for balance sheet
accounts).

 

Click the Account button to
create new accounts or
perform tasks with existing
accounts. 2

The Chart of Accounts list
shows the balance of each 
balance sheet account for 
your business.

1

 Rearrange your accounts by 
 clicking and dragging the 
 diamond, located to the left
  of an account, to a new
  position.

Set up QuickBooks to 
automatically remind you
when to enter checks for
an account.

Click here to view and 
select additional accounts
you can create (when
available).

3

5

8
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Adding an Account
When you set up your company file, QuickBooks sets up certain 
accounts for you automatically. However, as your business 
grows or changes, you might need to add new accounts to your 
chart of accounts to better organize your finances. Or, you 
might need an account that was not provided during setup. For 
example, you might want to create expense accounts to track 
office supply purchases separately from advertising costs.

To add an account:

➊ Go to the Lists menu and click Chart of Accounts.

➋ Click the Account button and then click New.

➌ In the Add New Account: Select Account Type window, 
select the type of account you want to create and then click 
Continue.

Note: Refer to pages 28 and 29 for a description of the different 
types of income, expense, and balance sheet accounts.

➍ Enter the account’s name in the Account Name field. This 
name will appear on your company financial statements.

➎ If you want to make this account a subaccount of another 
account, select the Subaccount of checkbox. From the 
drop-down list, select the account that will be the higher-
level account for this subaccount.

➏ (Optional) Enter a short description, note, bank account 
number, or credit card number, depending on the type of 
account you are adding.

➐ For income and expense accounts. From the Tax-Line 
Mapping drop-down list, select the appropriate tax line or 
<Not tax-related>.

➑ For balance sheet accounts. Enter an opening balance 
based on the account’s balance as of your QuickBooks 
start date. Generally, you should enter any balance sheet 
balances as of the day before your start date. That way 
it’s all exactly correct at the opening of your start date. If 
you’re putting money into the account with a transaction, 
do not use the opening balance field, since this will create 
an additional transaction. If you’re not sure of the balance, 
you can leave the field blank and enter the information 
later. Click OK when finished.

➒ Click Save & Close or Save & New to add another account.

Accounts
There are two types of 
accounts—balance sheet 
accounts, such as checking 
and savings, and income 
and expense accounts, 
which are used to group 
transactions for reporting 
purposes. (Income and 
expense accounts are the 
same as “categories” in 
Quicken.) Refer to pages 28 
and 29 for a description of 
the different QuickBooks 
accounts.

Chart of Accounts
A complete list of your 
business’ accounts and their 
balances. You use a chart 
of accounts to track how 
much money your company 
has, how much money it 
owes, how much money is 
coming in, and how much is 
going out.

Did You Know?

The IRS recommends 
opening a business checking 
account as one of the first 
things you do when starting 
a new business.

Intuit highly recommends 
associating your income 
and expense accounts with 
the appropriate tax lines for 
your tax forms. Consult with 
your accountant if you need 
more information about 
which tax forms to use and 
to which tax lines to map 
each account.

Key Terms
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Why Use Subaccounts?
When you need more detail about what’s going on in an account, you can divide the account 
into one or more subaccounts. Subaccounts let you track several related types of income or 
expenses independently yet keep them all under the “umbrella” of a single parent account. 
Subaccounts appear indented immediately below their parent account in your chart of 
accounts. If you create subaccounts, it’s best not to post anything to the “parent” account. For 
example, if your business has substantial advertising expenses, you might decide to divide your 
Advertising expense account into several subaccounts, such as Newspaper Ads, Signs, Yellow 
Pages Listing, and Direct Mailings.

What type of account should I use?
There are two main types of accounts in the QuickBooks chart of accounts:

• Income and expense accounts

• Balance sheet accounts

Income and Expense Accounts
Income and expense accounts track the sources of your income and the purpose of each 
expense. When you record transactions in one of your balance sheet accounts, you usually 
assign the amount of the transaction to one or more income or expense accounts. For 
example, not only do you record that you took money out of your checking account, but you 
keep track of what you spent the money on (utilities or office supplies).

Account type Purpose

Income Categorizes money earned from normal business operations, such as product 
sales, service sales, and discounts to customers.

Other income
Categorizes money your business earns that is unrelated to normal business 
operations, such as dividend income, interest income, and insurance 
reimbursements.

Expense
Categorizes money spent in the course of normal business operations, 
such as advertising and promotion, office supplies, insurance, legal fees, 
charitable contributions, and rent.

Other expense
Categorizes money your business spends that is unrelated to normal 
business operations, such as corporation taxes and penalties, interest, and 
legal settlements

Cost of goods sold Tracks the direct costs to purchase or produce the items that your business 
sells, such as cost of materials, cost of labor, subcontractors, and shipping.

Note: QuickBooks does not display balances for income and expense accounts in the Chart of Accounts. To see 
these balances, choose the Reports menu, choose Report Center, and then click the Company & Financial 
category. You can also select the income or expense account in the chart of accounts and click QuickReport.
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Balance Sheet Accounts

QuickBooks provides 10 types of balance sheet accounts to choose from as you create 
and add to your Chart of Accounts. Use the type of account that best describes the type 
of data you are tracking.

Account type Purpose

Bank

Tracks money you have in your cash accounts. Create one for each cash 
account, such as petty cash, checking, savings, and money market. (When 
you create a new bank account, leave the opening balance at zero. Its 
opening balance will be created automatically when you transfer funds from 
another account.)

Accounts 
receivable 
(A/R)

Tracks money your customers owe you on unpaid invoices. Most businesses 
require only the A/R account that QuickBooks automatically creates after 
you create your first invoice. 

Other current asset
Tracks the value of things that you can convert to cash or use up within one 
year, such as prepaid expenses, employee cash advances, inventory, and 
loans from your business.

Fixed asset
Tracks the value of significant items (consult your tax professional for a 
minimum dollar amount) that have a useful life of more than one year, such 
as buildings, land, machinery and equipment, and vehicles.

Other asset
Tracks the value of things that are neither Fixed Assets nor Other Current 
Assets, such as Goodwill, long-term notes receivable, security deposits paid, 
and land.

Accounts payable 
(AP)

Tracks money you owe to vendors for purchases made on credit. Most 
businesses require only the A/P account that QuickBooks automatically 
creates after you create your first invoice.

Credit card Tracks credit card purchases, bills, and payments. Create one for each credit 
card your business uses.

Other current 
liability

Tracks money your business owes and expects to pay within one year, such 
as sales tax, security deposits/retainers from customers, and payroll taxes.

Long-term liability Tracks money your business owes and expects to pay back over more than 
one year, such as mortgages, long-term loans, and notes payable.

Equity Tracks money invested in, or money taken out of, the business by owners or 
shareholders. Payroll and reimbursable expenses should not be included.
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Customer Center

New Customer

 

Click New Customer & Job 
to add new customers to 
the list.

Click a customer’s name in
the list to view the contact
information and notes for
that customer.

View the amount of money
each customer owes you in
the Balance Total column.

2

4

Enter the customer’s name,
address, and contact 
information on the Address 
Info tab. 

Use the Additional Info and 
Payment Info tabs to set up 
customer payment terms and 
sales tax information.

5

Click Define Fields to create 
any custom fields that you 
need for your customers.

See all transactions for this
customer in the transaction
list, which can be sorted and
filtered.

Click to view useful reports
about each customer.

3



Setting Up Your Business

31

Adding Customers
Customers are the lifeline of your business. By entering 
detailed information in QuickBooks about the people and 
companies to whom you sell your products and services, you 
can personalize their bills, send invoices easily, and quickly 
view the status of their accounts. You can add new customers 
at any time.

Tip:  Typing in customer data for hundreds of 
customers can be a tedious task. If you use Microsoft 
Outlook, you can import your existing customer 
information into QuickBooks instead of entering it 
manually. Refer to the QuickBooks in-product Help for 
instructions on how to prepare your customer data file 
for importing into QuickBooks. 

To add a customer:

➊ Click the Customer Center icon at the top of the 
QuickBooks window.

➋ Click New Customer & Job and then click New Customer.

➌ On the Address Info tab, enter all the data that you have 
about the customer, including their name, Bill to and Ship 
to addresses, and additional contact information.

➍ Complete the Additional Info and Payment Info tabs, as 
appropriate.

➎ If you want to add additional fields to the form, click 
Define Fields to customize the form.

➏ Click OK or click Next if you want to enter another 
customer.

Tip:  You can also add customers as you perform 
your everyday tasks. For example, if you enter the 
name of a new customer when filling out an invoice, 
QuickBooks will prompt you to enter information about 
this customer. You can choose from two quick setup 
options:

• Quick Add—Adds just the name to the list. You must 
add the details later.

• Set Up—Enables you to enter additional information 
(such as a phone number, fax number, and alternate 
contact) to the list you choose.

Customers
Customers are the people or 
businesses to whom you sell 
your products or services—
that is, the people who pay 
you for what you do. Some 
businesses might refer to 
a customer as a client or 
member.

Did You Know?

Adding jobs
If you are performing more 
than one job for a customer, 
you can track the jobs 
individually by adding new 
jobs under the customer’s 
name in the Customers & 
Jobs list. That way, you can 
create reports that show the 
income and expenses for 
each job. To add a job, click 
New Customer & Job and 
then click Add Job.

Adding multiple customers 
at once
If you need to add 
several customers to your 
QuickBooks company file, 
consider using the Add/edit 
multiple list entries feature 
described on page 10. For 
more information, refer to 
the in-product Help.

Key Term
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Vendor Center

New Vendor: Additional Info

Use the Additional Info tab  
to enter vendor-specific 
information, including the 
vendor type.

Click Define Fields to create 
any custom fields that you 
need for your vendors.

 

View the amount of money
you owe each vendor in the 
Balance Total column.

3

Enter the vendor’s name, 
address, and contact 
information on the Address 
Info tab. 

5

6

Click New Vendor to add
new vendors to the list.

2

Click a vendor’s name in
the list to view the contact
information and notes for
that vendor.

See all transactions for this 
vendor in the transaction
list, which can be sorted and
filtered.

Click to view useful
reports about each vendor.
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Adding Vendors
QuickBooks uses the vendor list to hold information about 
the people and companies you buy goods and services from 
to run your business. For example, this list could include the 
phone company, your office supplies vendor, and your tax 
board. You can add new vendors at any time.

Tip:  Typing in vendor data for hundreds of vendors 
can be a tedious task. If you use Microsoft Outlook, 
you can import your existing vendor information into 
QuickBooks instead of entering it manually. Refer to 
the QuickBooks in-product Help for instructions on 
how to prepare your vendor data file for importing into 
QuickBooks.

To add a vendor:

➊ Click the Vendor Center icon at the top of the QuickBooks 
window.

➋ Click New Vendor.

➌ On the Address Info tab, enter all the data that you have 
about the vendor, including the vendor’s name, address, 
and additional contact information.

➍ If you owe this vendor money as of your company’s start 
date, enter the amount in the Opening Balance field. 

➎ Click the Additional Info tab and complete the form.

➏ If you want to add additional fields to the form, click 
Define Fields to customize the form.

➐ Click OK or click Next if you want to enter another vendor.

Tip:  You can also add vendors as you perform your 
everyday tasks. For example, if you enter the name of a 
new vendor when paying a bill, QuickBooks will prompt 
you to enter information about this vendor. You can 
choose from two quick setup options.

• Quick Add—Adds just the name to the list. You must 
add the details later.

• Set Up—Enables you to enter additional information 
(such as a phone number, fax number, and alternate 
contact) to the list you choose.

Vendors
Vendors are any businesses 
or people from whom you 
buy or rent goods or services 
for your business—office 
supplies, phone or computer 
services, or products that 
you sell. The tax agencies 
that you pay are also your 
vendors. Nearly everyone 
you pay other than 
employees are vendors.

Did You Know?

Adding multiple vendors 
at once
If you need to add several 
vendors to your QuickBooks 
company file, consider using 
the Add/edit multiple list 
entries feature described 
on page 10. For more 
information, refer to the 
in-product Help.

Key Term
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Item List

New Item

Subitems are indented under 
the parent item.

3

Select the type of item you 
want to create from the Type 
drop-down list.

 

 

For inventory parts, the 
On Hand column shows how 
many of each item you have 
in stock.

Click the Item button to add
new items or perform 
activities on existing items. 2

Click the Custom Fields button
to set up and fill in custom 
fields that you need for your
items.

Enter the amount you want to 
charge for the item here.

Associate the item with an 
account here.

Choose the appropriate tax
code here.

6

7

8
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Adding Items
In QuickBooks, an item is anything that your company buys, 
sells, or resells to run your business. Items are your products, 
services, and things such as shipping and handling charges, 
discounts, and sales tax.

When you select an item from the Item list, QuickBooks fills 
in a description of the line item and calculates its amount for 
you.

QuickBooks provides 12 different types of items, described in 
the table on page 36. Some items, such as service or inventory 
part items, help you record the services and products your 
business sells. Other items, such as the subtotal or discount 
item, are used to perform calculations on the amounts in a 
sale.

To add an item:

➊ Choose the Lists menu and choose Item List.

➋ Choose Item at the bottom of the list and then choose 
New.

➌ Click the Type drop-down arrow and select the type of 
item you want to create (see table on page 36).

➍ Enter an item name as you want it to appear on purchase 
and sales forms.

➎ Enter the description that you want to appear on sales 
forms when you use the payment item.

➏ In the Rate field, enter the amount you want to charge for 
the item or, if the rate varies, leave as zero.

➐ In the Account field, choose the account that is 
associated with this item. (In most cases, you will assign 
the item to an income account.)

➑ In the Tax Code list, select the appropriate sales tax code 
or create a new one. If you do not see the Tax Code list, 
you must turn the tax preference on in the Sales Tax area 
under Edit | Preferences.

➒ Click OK or click Next if you want to enter another item.

Items
An item is anything that 
might appear as a line item 
on an invoice, including 
subtotals, discounts, and 
sales tax, as well as the 
products and/or services 
that you sell. You enter 
items on your invoices and 
sales receipts. For example, 
a writing consultant might 
set up one item for editing 
services with an hourly rate, 
and another item for writing 
services with a different 
hourly rate. On an invoice, 
the items would be entered 
with the number of hours 
worked as the quantity.

While providing a quick 
means of data entry, items 
also handle the behind-
the-scenes accounting. 
When you create an item 
you link it to an account. 
When the item is used on 
a form it posts an entry to 
that account and another 
to the appropriate accounts 
receivable, accounts payable, 
checking, or other account.

Did You Know?

Adding multiple items at 
once
If you need to add several 
items to your QuickBooks 
company file, consider using 
the Add/edit multiple list 
entries feature described 
on page 10. For more 
information, refer to the 
in-product Help.

Key Term
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Which Item Type Should I Choose?
QuickBooks provides 12 different types of items to help you fill out sales and purchase forms 
quickly.

Item Type Purpose

Service Use for services you either charge for or purchase, like specialized labor, 
consulting hours, and professional fees.

Inventory part Use for goods you purchase, track as inventory, and resell.

Inventory 
assembly (Premier 
only)

Use for assembled goods you build or purchase, track as inventory, and resell.

Non-inventory part Use for goods you buy but don’t track, like office supplies or materials you 
buy for a specific job that you charge back to your customer.

Fixed asset
Use for an asset you do not expect to convert to cash during one year of 
normal operations. A fixed asset is usually something that is necessary for 
the operation of your business—like a truck, cash register, or computer.

Other charge Use for miscellaneous labor, material, or part charges, such as delivery 
charges, setup fees, and service charges.

Subtotal Use to total all items above it on a form, up to the last subtotal. Useful for 
applying a percentage discount or surcharge to several items.

Group Use to quickly enter a group of individual items on an invoice.

Discount
Use to subtract a percentage or fixed amount from a total or subtotal. Do 
not use this item type for an early payment discount; for an early payment 
discount, use the Set Discount feature in the Receive Payments window.

Payment Use to record a partial payment you received at the time of the sale. It 
reduces the amount owed on an invoice.

Sales tax item Use to calculate a single sales tax at a specific rate that you pay to a single 
tax agency.

Sales tax group Use to calculate and individually track two or more sales tax items that 
apply to the same sale. The customer sees only the total sales tax.
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Why item types are important
Although you can use items as a quick means of entering data, items fulfill a much more 
important QuickBooks role: to handle the behind-the-scenes accounting. 

When you create an item, you link it to an account; when the item is used on a form, it posts 
an entry to that account and another entry to the appropriate accounts receivable, accounts 
payable, checking, fixed asset, or other account.

While items are easy to set up, you should spend some time deciding how they can best work 
for you before you start setting them up and using them. Use your current list of services and 
products as a starting point. Consider how much detail you want on your invoices or statements 
and set up your items with that level of detail in mind. For example, if you are a seamstress who 
creates and sells home accessories, you can set up a single item and charge a flat rate for a 
certain size of couch pillow, or you can break that pillow down further into labor and materials.

Furthermore, QuickBooks provides many useful reports that break information down by the 
goods or services you purchase and sell. That way, you can quickly find out:

• How much income your items bring in 

• What you are spending to purchase items 

• How well you estimate the cost of items 

• How much time you spent on each type of job or item
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Depending on where you do business, you might be required to collect sales tax for the products 
or services you sell. If you collect sales tax, you must pay it to a tax agency on a regular 
schedule. QuickBooks helps automate your sales tax tracking so you can keep accurate records 
about the sales tax you collect and pay.

Important: You must follow the rules and regulations for collecting and paying sales tax in your tax district 
(city, county, state).

Understanding how sales tax works
QuickBooks uses sales tax codes to track the taxable or non-taxable status of both the items 
you sell (products and services) and your customers. If your tax agency requires you to report 
the reasons why particular sales are taxable or non-taxable, the sales tax codes that you assign 
to your items and customers enable you to run reports that provide this information for your 
sales tax return.

QuickBooks uses sales tax items to calculate and add sales tax charges when you make a 
taxable sale. When you set up a sales tax item, you assign a sales tax rate to it and associate it 
with the tax agency to which you pay the sales tax. All of the sales tax items you set up are in 
your Item list. Once you’ve set up sales tax, QuickBooks automatically applies the appropriate 
sales tax rate to the sale of your taxable items.

Before you start setting up sales tax
To set up sales tax in QuickBooks, you need to know the following sales tax requirements for the 
locations where you sell your products and services:

• Sales tax rates for each tax district (a city, county, or state that has a sales tax) in which you 
sell. You may have multiple sales tax rates that you need to charge, for example, sales tax for 
both a county and a state.

• Tax agencies to which you pay the collected sales tax for each of those district taxes.

Tip:  You can find your sales tax requirements (rates, payment schedules, etc.) online 
at your state sales tax Web site. We have provided access to these Web sites from the 
in-product Help. Go to the Help menu and click QuickBooks Help. In the Search field, enter 
Finding the sales tax rates and requirements for your business. Select that topic, and then 
click the link for your state.
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Term How it relates to sales tax setup

Sales tax rate

The percentage charged for sales tax by the tax district. For each different 
district/rate combination, you need to set up a new sales tax item. For 
example, you might sell in three counties that all charge the same sales tax 
rate, but you need a separate sales tax item for each county, even though 
the sales tax rate is the same. This enables you to track the amounts of sales 
tax you collect for each tax district.

Sales tax item

A QuickBooks item that is used to calculate the appropriate sales tax for a 
sale. A sales tax item includes a sales tax rate and a tax agency. When you 
sell taxable items, you charge the appropriate sales tax rate by assigning a 
sales tax item to each sale.

Sales tax group 
item

A QuickBooks item that groups multiple sales tax items so you can charge 
only one rate on your sales. For example, the location where you sell 
might require you to charge both a county and a state sales tax. However, 
customers are used to seeing one sales tax rate on sales. You would set up a 
sales tax group item that combines those two sales tax rates, say 1% for the 
county and 7% for the state, to create a single, sales tax group item with a 
rate of 8%. You would apply this sales tax group item to your taxable sales 
for that county. 

Sales tax code

The identifier that QuickBooks uses to track the taxable and non-taxable 
status of both the products and services you sell, and the customers to 
whom you sell these items. For example, a customer that is a non-profit 
organization might have a non-taxable status. You would not charge sales 
tax for anything you sell to this particular customer. 

Tax district
A town, city, county, or state that charges sales tax. A tax district might also 
include a municipal or special jurisdiction, such as a Mass Transit tax or a 
parish in Louisiana.

Tax agency

The government office that determines the requirements for sales tax 
collection or payment. You might need to pay your collected sales tax to 
one or more tax agencies, depending on the requirements for the locations 
(tax districts) where you do business. Tax agencies are set up as vendors, 
because you make payments to them. A tax agency is sometimes called a 
tax authority.
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Preferences: Set sales tax preferences

Verify that you have sales tax
turned on.

Choose when you owe sales
tax to your tax agency.

5

Choose when you pay sales
tax to your tax agency. 6

4

Choose the sales tax item 
you want to use as the preset 
sales tax rate on all your 
sales forms (invoices, sales
receipts, and so on).
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Setting up sales tax
Setting up sales tax is a multi-step process, divided into three 
main parts:

• Part 1: Sales tax payment schedule

• Part 2: Sales tax codes to track taxable status of items and 
customers

• Part 3: Sales tax items, rates, and tax agencies

Part 1: Sales tax payment schedule
In this procedure, you’ll turn on sales tax and then set up 
information about when you need to pay your tax agency.

To set up your sales tax payment schedule:

➊ Choose the Edit menu and choose Preferences. 

➋ Click Sales Tax in the list on the left.

➌ Click the Company Preferences tab. 

➍ For the question Do You Charge Sales Tax, click Yes.

➎ Select when you owe sales tax to the tax agency, as 
specified by your tax agency.

• Select As of invoice date if your tax agency stipulates 
that you owe sales tax from the moment you write an 
invoice or make a sale.

• Select Upon receipt of payment if your tax agency 
stipulates that you owe sales tax when you receive the 
payment from a customer.

Note: This preference overrides the accounting basis you’ve set 
for your company and for your report preferences (if your report 
preference is set to “cash” but you select “accrual” here, your 
sales tax reports will be accrual-based).

➏ Select how often you pay sales tax, as specified by your 
tax agency. If you don’t know which time period to 
choose, check your sales tax license. It should indicate the 
payment schedule that you need to use.

Tip:  If you collect sales tax for multiple tax agencies 
that require payment at different intervals, use the 
payment interval you use most frequently. When you 
run your sales tax reports and make your payments, 
you’ll be able to see which amounts are due on which 
dates.

About the Manage Sales 
Tax window
The Manage Sales Tax 
window helps you complete 
all of your common sales tax 
tasks, like setting sales tax 
preferences, preparing state 
sales tax forms, and paying 
sales tax. Go to the Vendors 
menu, click Sales Tax, and 
then click Manage Sales 
Tax to open this window.

Setting the time interval 
for paying your sales 
tax affects reports and 
reminders.
The time interval you 
select to pay your sales tax 
is reflected in the period 
of time covered by your 
sales tax reports and sets 
reminders to pay your sales 
taxes.

For example, if you select 
Monthly, QuickBooks uses 
the previous month as the 
basis for your sales tax 
reports. When it’s time to 
pay your sales tax using 
the Pay Sales Tax feature, 
QuickBooks reminds you to 
make the payment.
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Preferences: Set up sales tax codes

Add sales tax codes by clicking
the drop-down list for the type
of sales tax code you want to 
set up and select <Add New>.

1

Enter the sales tax code and a
short description.

2
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Part 2: Sales tax codes to track taxable status of items and customers
Now you’ll set up the sales tax codes that you’ll use to track the taxable and non-taxable sales 
status of your items and customers. Later, you’ll assign these sales tax codes to your customers 
and the items you sell.

QuickBooks creates two sales tax codes for you:

• The taxable code (TAX) is assigned to items and customers that are taxed. 

• The non-taxable code (NON) is assigned to items and customers that are not taxed, such as 
non-profit organizations or items that the customer plans to resell.

Depending on your tax agency requirements, these two preset sales tax codes might be all 
you’ll need. You won’t need to set up any additional codes or change this preference.

If your tax agency requires you to specify additional sales tax codes to track taxable and non-
taxable sales, such as specific tracking for out-of-state sales, you can set them up now. (You can 
also set them up later when you need to use them.)

To set up additional sales tax codes:

➊ Click the drop-down list for the type of sales tax code you want to set up (Taxable or Non-
taxable) and select <Add New>. 

➋ In the New Sales Tax Code window, enter a sales tax code you want to use and a 
description for it.

Each sales tax code you add must be unique. For example, you might want to set up a non-
taxable sales code for labor costs. You might enter LBR as the sales tax code and “Labor, 
non-taxable” as the description. Many businesses also use a non-taxable out-of-state sales 
tax code (OOS).

➌ Click OK.

➍ Repeat steps 1 through 3 for each sales tax code you want to add.

Part 3: Sales tax items, rates, and tax agencies
You need to set up a sales tax item for each tax district (city, county, state) in which you sell. 
A sales tax item includes the sales tax rate you need to charge for that tax district and the tax 
agency to which you remit the sales tax you collect. Even if you sell in three different counties 
that all have the same sales tax rate, you need to set up a separate sales tax item for each 
county/rate combination so that you can properly track your sales tax collection and payments.

To set up your sales tax items, rates, and tax agencies:

➊ Click Add sales tax item.

➋ Click the Type drop-down arrow and then select Sales Tax Item.

➌ Enter the sales tax name. (Use a name that describes the location for the Tax, such as San 
Mateo County. This name will appear as one of the choices in the Tax field on your sales 
forms.)
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➍ Enter a description for the way this sales tax item will appear as a line item on your sales 
forms (for example, San Mateo County sales tax). You can’t edit it on the forms 
themselves. Users frequently use the name of the sales tax item as the description.

➎ Enter the sales tax rate (as a percentage) you charge when a sale is taxable. For example, 
your sales tax rate for San Mateo County might be 1.25% (or 1.25 cents per dollar 
purchased).

➏ In the Tax Agency drop-down list, click <Add New> to open the New Vendor window, where 
you’ll set up the tax agency (a vendor) to which you pay this sales tax.

➐ Enter a vendor name and contact information. For example, in California, sales tax is paid to 
the Board of Equalization.

➑ Click OK to close the New Vendor window.

➒ Click OK to close the New Item window.

❿ Repeat steps 1 through 9 for each local, county, or state sales tax item and rate you need to 
set up.

Important: Depending on your sales tax requirements, you might need to combine multiple sales tax 
items to create a sales tax group item. For example, a county sales tax rate of 1.25% and a state sales 
tax rate of 7.0% would combine for a sales tax group item with a sales tax rate of 8.25%. Then, you can 
use this single sales tax rate on your sales forms.

⓫   When you’re finished setting up all your sales tax items, choose your Most common sales 
tax, which is the one you charge most often. Remember, the most common sales tax that 
you charge your customers might be a sales tax group item.

⓬   In the Sales Tax preferences window, decide whether or not you want to mark your taxable 
items when your sales forms are printed. If not, clear this checkbox.

⓭   Click OK to apply your sales tax preferences.

⓮ If you’ve already set up your items and customers, you’ll be prompted to assign a taxable 
sales tax code to all of them. Click OK if most of your items and customers are taxable. If 
not, clear the checkboxes and click OK.
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Entering an opening balance for  
sales tax liability (what you owe)
You need to enter an opening balance for your Sales Tax 
Liability account (what you owe as of your QuickBooks start 
date). After your start date, your sales tax is included on your 
sales forms and entered into this account.

Caution:  Do not use this procedure if you entered 
historical invoices or sales receipts dated before your 
QuickBooks start date. Your sales tax will already be 
included on them and posted to this account. You can 
also skip this procedure if you entered an opening 
balance for each tax agency as you set it up.

To enter your sales tax liability for a tax agency:

➊	 Go to the Lists menu and choose Chart of Accounts.

➋ Double-click the Sales Tax Payable account.

➌ In the register, find a blank transaction and fill in the 
details for the tax agency owed:

• In the Date field, enter your QuickBooks start date. 

• In the Vendor field, enter the tax agency.

• In the Billed field, enter the amount you owed as of 
your start date. 

• From the Account drop-down list, choose Opening Bal 
Equity.

➍ Click Record.

➎ Repeat steps 3 and 4 for each tax agency to which you 
owed sales tax as of your QuickBooks start date.

Sales tax group items
In many states where you 
charge a state sales tax rate, 
you also need to charge for 
a city or county sales tax 
along with it. However, your 
customers are used to just 
seeing one sales tax item 
on their invoices or sales 
receipts. You can resolve this 
issue by creating sales tax 
group items. Once you’ve 
set up all of your sales tax 
items for your city, county, 
and state sales tax rates, 
you’ll be ready to combine 
the rates to create a sales 
tax group item. 

Refer to the in-product Help 
for information on setting 
up a sales tax group item.
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Setting Up Your Business  |  Setting up your Payroll

 

 

Click Company Setup to enter
information about the types of
compensation and benefits
you provide.

Click Employee Setup to enter
employee personal, pay, and 
tax withholding information.

Click Taxes to enter employer-
specific tax rates and any
local taxes.

Click Year-to-Date Payrolls to enter 
year-to-date payroll history.

Payroll Setup
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Setting up your Payroll
As an employer, you have specific payroll responsibilities 
that are required by government agencies. These agencies 
can be federal, state, or local. Some of these responsibilities 
include, but are not limited to, withholding amounts from 
your employees’ compensation to cover income tax, Social 
Security, Medicare, and other payments.

Choosing a payroll service
To use QuickBooks to manage your payroll, you first need to 
subscribe to a QuickBooks payroll service. QuickBooks’ flexible 
options ensure that you get the payroll service that is right 
for you. QuickBooks also includes payroll features that don’t 
require a payroll service subscription. Refer to the in-product 
Help for more information about using payroll without a 
payroll service.

To learn about and sign up for a Payroll Service:

➊	 Go to the Employees menu and click Payroll.

➋ Click Learn About Payroll Options.

Or, if you are not sure which payroll service is right for you, 
contact one of our payroll experts at 1-866-820-6382 to learn 
more and help you choose.

Note: If you choose to sign up for a payroll service, you will be 
prompted to complete the activation process for your service. After you 
complete your activation, you can set up payroll for your business as 
described in the next section.

Setting up payroll
QuickBooks Payroll includes an easy-to-use Payroll Setup 
interview that guides you through setting up payroll for your 
business. Payroll Setup helps you set up your employees, set 
up compensation and benefit information, and enter any 
year-to-date payroll data. The Payroll Setup interview also 
guides you through setting up scheduled payments for your 
payroll tax and non-tax liabilities (such as health insurance 
and 401(k)). Scheduled payments help you manage your 
payroll more efficiently.

Did You Know?

Intuit Payroll Services
Intuit offers a variety of 
payroll services to meet 
your needs. QuickBooks 
Basic Payroll includes tools 
and tax tables to help you 
efficiently run your payroll 
and pay your payroll taxes. 
(Basic Payroll does not 
include payroll tax forms.)

QuickBooks Enhanced 
Payroll adds federal and 
state forms, E-File and E-Pay 
tools for tracking workers’ 
compensation costs, and 
tools for easily calculating 
bonuses. Enhanced Payroll 
lets you to process payroll 
for up to three business 
entities (EINs). 

QuickBooks Enhanced 
Payroll for Accountants 
includes all of this, plus 
after-the-fact payroll, 
client-ready reports, and the 
ability to process payroll for 
up to 50 specific businesses. 

With QuickBooks Assisted 
Payroll, Intuit handles your 
tax payments and filings 
for you.

All QuickBooks payroll 
services offer direct deposit 
of employee paychecks for 
a small additional fee. For 
more information about 
payroll services, go to the 
Employees menu, click 
Payroll, and then click Learn 
About Payroll Options.
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Before you begin setting up payroll, we recommend you gather all of the information in the 
Payroll Setup Checklist on page 49. (A PDF version of the Payroll Setup Checklist is available 
online at www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf.) You can find this 
information in your own records, from your accountant or QuickBooks Professional Advisor, or 
from federal and/or state agencies.

To set up payroll for your business:

➊	 Go to the Employees menu and choose Payroll Setup.

➋ Follow the onscreen instructions.

Tip:  If you need to leave the Payroll Setup interview at any time before completing 
all of your payroll setup tasks, click the Finish Later button. When you reopen the 
Payroll Setup interview, you can continue where you left off. To ensure accurate payroll 
calculations, complete your setup before using Payroll.

Payroll Setup has been grouped into the following categories:

• Company Setup – Enter information about the types of compensation and benefits you 
provide.

• Employee Setup – Enter employee personal information (name, hire date, Social Security 
number, and so on), pay information (pay rate, payments and deductions, paid time-off 
balances, and so on), and tax withholding information (from W-4 and state forms).

• Taxes – QuickBooks Payroll automatically sets up your state and federal taxes. However, you 
must still enter employer-specific tax rates (such as state unemployment insurance) as well as 
any local taxes that may apply.

• Year-to-Date Payroll – If you have issued paychecks to W-2 employees during this calendar 
year prior to using QuickBooks Payroll, you must provide year-to-date payroll history to 
accurately generate tax payments and filings.

Note: After your initial payroll setup, you might need to add new employees or edit employee payroll 
information. You do not need to use the Payroll Setup wizard for these quick tasks. Instead, follow the 
instructions for adding and editing employee information listed on page 51.

www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf
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Payroll Setup Checklist

Item Examples

Company 
Information

• Pay period frequency or frequencies (weekly, every other week, twice a 
month, monthly, quarterly)

• Date you started or will start using payroll in QuickBooks

Compensation, 
Benefits, and 
Miscellaneous 
Additions and 
Deductions

• Compensation you give employees and officers: hourly wages, salaries, 
commissions, etc.

• Insurance benefits offered, such as health, dental, vision
• Retirement benefits offered, such as 401(k)
• Additional deductions from net pay that you withhold, such as union dues, 

repayments of employee advances or loans, and life insurance
• Additions you add to a paycheck, such as bonuses, travel reimbursements, 

employee advances, or loans and tips

Tax Information

• Federal forms you’ll need to file, such as 941, 943, or 944 (for more 
information, see www.irs.gov) and your federal tax ID number (FEIN)

• Payroll bank accounts and the deposit frequency for these taxes
• State or states for which you file payroll taxes
• Your state employer tax ID number or numbers (EINs)
• Payees and account numbers for each state and local tax
• Tax rates for any local or other taxes
• Whether you qualify for the Federal Unemployment Tax (FUTA) credit

Employees

• Employee names, addresses, and Social Security numbers from your 
employees’ Social Security cards or W-4 forms

• Employee withholdings or allowances, which can also be found on the W-4 
form

• Current employee wages/salaries, additions, deductions, and company 
contributions

• Sick and vacation time policies and hours accrued

Direct Deposit 
Information

Note: This is an optional feature that requires additional fees.
• For each employee you want to pay using Direct Deposit, you need bank 

account and routing numbers.

Year-to-Date 
History

Note: You need to enter year-to-date amounts only if you start using 
QuickBooks Payroll after January 1 of the calendar year and if you have 
already run payroll at least once since January 1. (If you start using 
QuickBooks Payroll after January 1 but have not run a payroll yet this 
calendar year, you have no year-to-date information to enter.)
• Quarterly and pay period summaries of employee payroll amounts from 

the beginning of this calendar year to the beginning of the current quarter
• Paycheck information from the beginning of the current quarter to today

Liability Payment 
Information

• Quarterly and pay period summaries of payroll liability payments from the 
beginning of this year to your start date

• Copies of payroll liability checks from the first day of the current quarter 
until today

• Payment and filing methods
• Deposit frequencies

www.irs.gov
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Setting Up Your Business  |  Setting up Employees
New Employee: Personal Tab

Edit Employee: Payroll Info

Enter the employee’s personal
information, including the 
employee’s Social Security 
number and the name to be 
printed on paychecks.

Enter the employee’s address
and contact information in the
Address and Contact tab.

If you are using the Direct
Deposit service of QuickBooks
Payroll or Assisted Payroll, click
Direct Deposit to enter the
employee’s bank information.

3

4

4

Enter additional payroll data
like wages, taxes, bonuses,
mileage reinbursements, 
health insurance deductions,
and 401(k) contributions in 
the Payroll Info tab.

 

 

Enter tax information, sick
time, and vacation time.

If you're using payroll sched-
ules, click the drop-down arrow 
and select a payroll schedule 
to assign to the employee. The 
Pay Frequency field updates 
and becomes grayed out.
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Setting up Employees
To process paychecks and prepare tax documents for your 
employees, you need to enter specific information about each 
of your employees in QuickBooks.

Note: If you are a QuickBooks Payroll subscriber, you will be prompted 
to add all of your employee information during payroll setup (described 
on page 47). Use the following procedure to edit employee information 
or to add additional employees at a later date.

Refer to the Payroll Setup Checklist on page 49 for a list of 
employee information to gather. (A PDF version of the Payroll 
Setup Checklist is available online at www.payroll.com/
support/PDFs/Misc/Payroll_Setup_Checklist.pdf.)

To set up an employee’s personal information: 

➊ Click the Employee Center icon at the top of the 
QuickBooks window.

➋ Click New Employee.

➌ On the Personal tab, fill in the form.

➍ Click the Address and Contact tab, fill in the form, and 
then click OK.

➎ When prompted to set up the employee’s payroll 
information, click Leave As Is.

To set up an employee’s payroll information:

➊ Click the Employee Center icon at the top of the 
QuickBooks window.

➋ Click the Employees tab and then double-click the 
employee’s name.

➌ From the Change tabs drop-down list, click Payroll and 
Compensation Info.

➍ Fill in the Payroll Info form.

➎ Click the Taxes button.

➏ Click the Federal tab and fill in the form, based on the 
employee’s W-4 information.

➐ Click the State tab and fill in the form.

➑ Click OK.

Once you’ve set up your employees, refer to “Paying 
Employees” on page 69 to learn about paying them.

Employees
Employees are people who 
work for your company. 
Employees can work 
full-time or part-time. If 
you have workers who 
need a 1099 (for example, 
subcontractors), set them up 
as vendors, not employees.

 
Did You Know?

 
Is the company owner an 
employee?
Generally, people in 
business for themselves 
are not employees of the 
company. However, if your 
company is incorporated, 
working corporate officers 
are considered employees. 
Check with your accountant 
or payroll professional to 
determine if the owner 
should be considered an 
employee and then set up 
the owner accordingly in 
QuickBooks.

Key Term

www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf
www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf
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Money In  |  Creating an Estimate

Create Estimates

 

 

Choose the Estimate template 
you want to use, or create 
your own.

Choose items to add to the 
estimate or create new items.

5

Print and mail or e-mail 
estimates to your customer. 6

 When you’re ready to bill the 
 customer, click here to convert 
 this estimate to an invoice.

4
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Creating an Estimate
You can use the estimate form to prepare estimates, bids, 
quotes, or proposals for your customers. You can change the 
title “Estimate” to anything that suits your business.

Filling in the estimate is similar to creating an invoice. And 
when it’s time to bill your customer, you can create the 
invoice directly from the estimate by clicking Create Invoice 
on the estimate’s toolbar. QuickBooks then creates the 
invoice, with all the information from the estimate filled in. 
Later, you can create reports that compare your estimated 
costs and revenue against your actual costs and revenue to 
see how accurate your estimates are.

To create an estimate:

➊ If necessary, turn on Estimates (described below), if you 
didn’t do this during the EasyStep Interview.

➋ Choose the Customers menu and choose Create Estimates.

➌ Enter the name of the customer or job.

➍ Click the Templates drop-down menu and select an 
estimate template.

➎ Fill in the estimate form.

➏ Click Print.

❼ Save the estimate.

To turn on the estimates feature:

➊ Choose the Edit menu and choose Preferences. 

➋ Click Jobs & Estimates in the list on the left and then click 
the Company Preferences tab. 

➌ Click Yes to the question, “Do You Create Estimates?” 

➍ To have QuickBooks warn you when you try to record an 
estimate with the same number as the existing estimate, 
select the Warn about duplicate estimates numbers 
checkbox.

➎ If you do progress invoicing:

• Make sure Yes is selected in response to the question, 
“Do You Do Progress Invoicing?”

• Specify whether you want line items that have zero 
amounts to print on your progress invoice

➏ Click OK.

Estimate
An estimate is a form you 
use to itemize the work 
you propose to do or the 
products you intend to 
sell to a customer. Your 
company might use a 
different term, such as bid, 
grant, or proposal. Estimates 
are optional, not mandatory, 
for all businesses.

Did You Know?

Using sales orders
In QuickBooks Premier and 
Enterprise Solutions editions, 
you can create sales orders 
to help you keep track of 
items that your customers 
have ordered but you have 
not yet delivered to them, 
for example because you do 
not have them in stock.

Refer to the in-product Help 
for instructions and tips on 
how to use sales orders.

Customizing forms
You can easily customize 
the look of your estimates 
using the new online 
customization tool. See 
“Customizing Business 
Forms” on pages 24–25 for 
more information. 



54

Money In  |  Creating an Invoice

Create Invoices

 

  
 

3

Choose the Invoice template 
you want to use or create 
your own.

5Choose items to add to the 
invoice or create new items.

6
Print and mail or e-mail 
invoices to your customer.

6
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Creating an Invoice
When your customers don’t pay you in full at the time you 
provide your service or product, or when they pay in advance, 
you need to track how much they owe you. You can use an 
invoice to help you keep track of what your customers owe 
you (or your “accounts receivable”).

Invoices list all the details about the sale, including the 
services you’re providing or the products you’re selling (your 
“items”). Invoices also show the quantity and price or rate of 
each item. If you need to make automatic adjustments to 
prices (for example, discounts or markups), invoices will work 
for you.

Note: If your customers pay in full at the time of purchase, do not 
create an invoice. Instead, create a sales receipt, described on page 57.

To create an invoice:

➊ Choose the Customers menu and choose Create Invoices.

➋  In the Customer:Job drop-down list, enter a name or 
select the name of the customer or job.

➌ Click the Template drop-down arrow and then select the 
invoice template you want to use.

➍ Click the Terms drop-down arrow and then select the sales 
terms that apply to this customer.

➎ In the lower part of the form, enter each of the items 
(including the proper quantity) that the customer has 
purchased.

➏ Click Print on the toolbar to print the invoice now. 
Optionally, you can select the To be printed checkbox to 
print the form later or the To be e-mailed checkbox to 
e-mail the form later.

➐ Save the invoice.

Tip:  You can customize your invoices (or any other 
sales form) for your business. Click Customize to open 
the new forms customization tool that you can use 
to give all your forms a consistent, professional look 
in just four simple steps. See “Customizing Business 
Forms” on pages 24–25 for more information.

Invoice
An invoice is the form you 
use to charge customers for 
the products and services 
they purchase from you.

Did You Know?

You can create an invoice 
letter directly from the 
invoice form by clicking the 
Letters button on the Create 
Invoices toolbar. Refer to 
the in-product Help for more 
detailed information about 
this feature.
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Sales Receipt

Choose items to add to the 
Sales Receipt or create new 
items.

4
 

Choose the Sales Receipts
template you want to use or 
create your own.

3
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Entering Sales Receipts
When your customers pay in full at the time they receive 
your service or product, you don’t need to track how much 
they owe you. However, you might want to record the sale, 
calculate its sales tax, or print a receipt for the sale. In these 
cases, you can create a sales receipt.

Examples of businesses that commonly use sales receipts 
include beauty salons, pet groomers, dry cleaners, and 
restaurants.

Note: If you need to track how much a customer owes you or you do 
not receive full payment at the time of the transaction, do not use a 
sales receipt. Instead, create an invoice, described on page 55.

To enter a sales receipt:

➊ Choose the Customers menu and choose Enter Sales 
Receipts.

➋ Fill in the top part of the form, including the Customer:Job, 
Date, and Payment Method.

➌ Click the Template drop-down arrow and then select the 
sales receipt template you want to use.

➍ In the bottom part of the form, select or enter the items 
purchased.

➎ Save the transaction.Tip:  You can customize your sales receipts (or any 
other sales form) for your business. Click Customize to 
open the new forms customization tool that you can 
use to give all your forms a consistent, professional 
look in just four simple steps. See “Customizing 
Business Forms” on pages 24–25 for more information.

Key Term

Sales Receipt
A sales receipt is the form 
you use when you make a 
sale for which you receive 
full payment at the time of 
the sale. Sales receipts can 
include payments by cash, 
check, or credit card.

Did You Know?

You can also use a sales 
receipt to create a summary 
of sales income and 
sales tax owed. You can 
summarize daily or weekly 
sales on a sales receipt.
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Receive Payments

2
Select a customer from the
drop-down list.

3The checkmark next to the 
invoice tells QuickBooks to 
apply the payment to this
invoice.
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Did You Know?
Receiving a Payment 
When you receive money from a customer, you must receive 
the payment in QuickBooks so QuickBooks can record the 
transaction and mark the invoice as being paid. When you 
receive a payment, the accounts receivable records are 
updated, and the payment is ready to be deposited into an 
account.

To receive a payment:

➊	 Choose the Customers menu and choose Receive 
Payments.

➋	 Fill in the top portion of the form, including the customer’s 
name, the payment amount, payment method, and the 
date on which the payment was received.

➌	 Check the column to the left of the invoice to which 
you want to apply the payment. You might be asked to 
decide how to apply the payment for one of the following 
scenarios:

• Overpayment can become a credit or refund

• Underpayment can be left as is or written off

• Customer has unused credit to be applied

• Customer has available discounts

➍ Choose the appropriate selection and you should see your 
choices reflected in total amounts for selected invoices.

If the customer has a discount or available credits, you 
can choose how to apply them.

➎ Save the payment.

You can set a preference so 
that payments received:
• Automatically go to 

the undeposited funds 
account

• Automatically get 
calculated and applied as 
you select invoices in the 
list 

Choose the Edit menu, 
choose Preferences, and 
then click the Company 
Preferences tab in the Sales 
& Customers area to set this 
preference.
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Payments to Deposit

Make Deposits

Click Payments to see other
payments you can deposit.

QuickBooks sorts received 
payments by payment method 
type.

2

3Indicates the account to 
which you want to deposit
the funds. 

5
Record cash back from a 
deposit by specifying the 
account and amount here.

The checkmark indicates 
which payments to deposit.
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Making a Deposit
When you receive a payment from a customer, you can either deposit the payment into a bank 
account immediately, or you can wait until a later time to make the deposit.

To make a deposit:

➊ Choose the Banking menu and choose Make Deposits.

➋ In the Payments to Deposit window, select the payments that you want to deposit and 
click OK.

➌ In the Make Deposits window, click the Deposit To drop-down arrow and then select the 
account to which you want to deposit the funds.

➍ Verify the date and the list of payments to deposit, making updates as necessary.

➎ If you want to receive cash back from this deposit, fill in the Cash Back fields at the bottom 
of the form.

➏ If you want to print a deposit slip or deposit summary, click Print.

➐ Save the deposit.

Note: Just because you’ve recorded the deposit in QuickBooks doesn’t mean you’ve actually made the 
deposit and that the money is available. You still need to physically deposit the money at the bank or send 
an online transfer.

Money In  |  Making a Deposit
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Enter Bills

Choose or enter the name 
of the vendor who sent you 
the bill. 2

Select the payment terms 
here and QuickBooks will
autofill the Bill Due date 
for you.

Enter the amount due here.

Assign the bill to one or more
expense accounts.

Pay Bills

Click here to display all 
unpaid bills or all bills that 
are due before a specific date. 2

The checkmark indicates the 
bills you’ve chosen to pay.

3

Click Go to Bill to view the 
bill that corresponds to the 
selected bill.

5

3
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Paying Bills
As you purchase equipment, supplies, products, or services to 
run your business, you will also receive bills that need to be 
paid. Entering these bills in QuickBooks enables you to not only 
track information about your purchases, but also to pay these 
bills. QuickBooks remembers all of your unpaid bills, enabling 
you to easily choose the bills you want to pay. QuickBooks then 
writes and saves the checks or credit card charges or sends 
the online banking payment instructions, depending on the 
payment method you choose.

Note: Before paying a bill, be sure you read the section “Writing checks 
versus paying bills” on page 11 to make sure you are using the correct 
payment method.

To enter a bill:

➊ Choose the Vendors menu and choose Enter Bills.

➋ In the Vendor field, choose or enter a new vendor.

Note: If an open purchase order exists for this vendor, you are 
prompted to receive against it. Click Yes to receive against one or 
more purchase orders; then, in the Open Purchase Orders window, 
click each purchase order that contains items you’ve received and 
are being billed for.

➌ Specify the Payment Method, Payment Account, and 
Payment Date.

➍ In the Amount Due field, enter the amount of the bill.

➎ Fill in the Date, Ref. No., Terms, and Memo fields as 
necessary.

➏ For expenses (money you spend to run your business, such 
as utilities), assign the bill to one or more expense accounts 
on the Expenses tab.  
For items (products or services your business buys), edit 
items that were entered from your purchase order or enter 
new items on the Items tab.

➐ Click Save & Close or click Save & New to enter the 
transaction.

To pay a bill:

➊ Go to the Vendors menu and click Pay Bills.

➋ All outstanding bills are displayed. To limit the number of 
bills displayed, click Due on or before and then click the due 
date for the bills you want to display.

➌ Click Pay Selected Bills to complete the transaction.

Writing checks vs. paying 
bills
Do not use the Write 
Checks window to write a 
paycheck, pay your payroll 
liabilities, pay sales tax, or 
pay bills you’ve already 
entered in the Enter Bills 
window.

Refer to the in-product Help 
for more information on 
how to make these types of 
payments.

Paying employees
Refer to page 69 for 
instructions on paying 
employees.

Paying bills
You don’t need to use the 
Pay Bills window to pay your 
bills. You can enter checks, 
credit card payments, and 
cash expenditures directly 
in the appropriate account 
register. However, if you 
enter bills using either 
the Enter Bills window 
or the Accounts Payable 
register, you must use the 
Pay Bills window for your 
bill payment. Do not use 
the Write Checks window 
to pay a bill that you’ve 
entered with either of these 
methods.

Did You Know?
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Set to OK 

Cancel 

Help 

Select All 

Select None 

Bank Account 

Date 
12/15/2007 
12/15/2007 
12/15/2007 

Daigle Lighting 
P erry Windows & Door s 
Sergeant Insu r anc e 

640.92 
6,935.75 

675.00 

196 

P a y e e Amount  

Select Checks to print, then click OK, 
There are 3 Checks to print for $8,251.67. 

Checking First Check Number 

xSelect Checks to Print 

Write Checks

Select Checks to Print

4
Click here to choose the
checks you want to print.

Make sure that the checks in
your printer correspond to the
check number entered here.

Use the Expenses tab to 
itemize purchases you make
to run your business, such as
job materials or utility costs.

4

Indicates the account from 
which the funds will be taken 
for this check. 2

Fill out the check just like 
you would a paper check. 3

Use the Items tab to itemize
the products and services
you’ve bought with or without
a purchase order.

5
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Writing Checks
You can write a check for any kind of expense that you track 
with QuickBooks expense accounts and for non-inventory 
part, service, and other charge items. If you are using 
inventory or purchase orders (Premier only), you can write 
checks for inventory part items too.

Note: Before writing a check, be sure you read the section “Writing 
checks versus paying bills” on page 11 to make sure you are using the 
correct payment method.

To write a check:

➊ Choose the Banking menu and choose Write Checks.

➋ Click the Bank Account drop-down arrow and then select 
the account from which you want to write the check.

➌ Fill in the onscreen check as you would a paper check.

➍ Itemize your expenses (shipping charges, taxes, or other 
expenses not associated with any one item) on the 
Expenses tab.

➎ If you are purchasing items for your inventory, enter the 
items on the Items tab.

➏ Save the transaction.

 
To find and print a single check:

➊ Load the blank check form into the printer.

➋ Go to the Banking menu and click Write Checks.

➌ Click the Find button and search for the check you want to 
print.

➍ Double-click to view the check you want to print.

➎ Click Print.

➏ In the Print Checks window, choose the options you want 
and click Print.

Note: To learn how to print multiple checks at the same time, refer 
to the in-product Help.

Writing checks vs. paying 
bills
You should not use the 
Write Checks window to 
write a paycheck, pay your 
payroll liabilities, pay sales 
tax, or pay bills you’ve 
already entered in the Enter 
Bills window.

Paying employees
Refer to page 69 for 
instructions on paying 
employees. You may be 
able to download credit 
card, debit card and other 
bank transactions right 
into QuickBooks instead of 
manually entering them. To 
learn more go to help and 
search on “online banking.”  

Did You Know?
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Credit Memo

Describe the reason for the 
return.

5

 

Select the template you
want to use, or create your 
own.

x
Previous Next

SOLD TO SHIP TO

P.0 NO. 

IT D S IPTION NTIT T O NT T x

D T S L  NO.

S e i Histor our Use Credit To 

Custom Credit Memo 

Tem te Customi e

C e r

Pro ess redit rd me t e  s vi

T x

T x

S ve  C ose

Create Credit Memos/Refunds 

Credit Memo 

Customer o

12/15/2007 

er  C ris
15 . Desert oom

s ore  C  2

Labor 5 70.00 350.00 

San  Tomas 7.75 0.00

350.00 Tota

Non

a er  C ris

Customer
Messa e

To be rinted To be e mai ed Customer Tax Code Remaining Credit    350.00 

92 

a e  e

 

The listed amount will be 
credited to your account

Memo

Job took 5 fewer hours than billed 
Enter the name of the 
returned item here.

2

Select whether to print and/or 
e-mail a copy to the customer.

7

3
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Issuing Credits or Refunds
Use a credit memo to record a credit when a customer 
returns items and you’ve already recorded an invoice, 
customer payment, or sales receipt. You can also use a credit 
memo for an overpayment.

To enter a credit memo or record a return:

➊ Choose the Customers menu and choose Create Credit 
Memos/Refunds.

➋ In the Customer:Job field, click the customer and job for 
which you are creating the credit memo or refund check.

Note: If you have created more than one job for the customer, be 
sure to assign the credit memo to the correct job. You can apply 
the credit memo only to the same job for which it was created.

➌ Click the Template drop-down arrow and select a 
template.

➍ Enter the items being returned in the line item area.

➎  Describe the reason for the credit and enter the quality 
and rate, if applicable.

➏ (Optional) Enter a memo for this transaction.

Note: The memo does not print on the credit memo, but it does 
appear in the Accounts Receivable register and in the customer 
register.

➐ Indicate whether you want to print or e-mail the credit 
memo to the customer. (You can choose to do both.)

➑ Save the credit memo.

➒ In the Available Credit window, choose how to use the 
credit. You can:

• Retain as an available credit

• Give a refund

• Apply it to an invoice

Note: QuickBooks enters a negative amount in your Accounts 
Receivable register for the credit memo.

Credit memo
A document that notifies 
a customer that you have 
reduced the customer’s 
balance. For example, 
when a customer cancels a 
sale, returns something, or 
overpays.

Key Term
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Enter Hours and Select Employees to Pay

Review and Create Paychecks

QuickBooks creates a 
paycheck for each employee 
name marked with a 
checkmark.

Specify a check date and
pay-period end date for the 
paychecks you create.

QuickBooks records the 
checks in this bank account.

Review paychecks and enter 
hours worked, sick or vacation 
time, commissions, or other 
variations from pay period to 
pay period by clicking the 
employee’s name.

2

4

3

6

Review paychecks and enter 
hours worked, sick or vacation 
time, commissions, or other 
variations from pay period to 
pay period by clicking the 
employee’s name.

If an employee is set up for
direct deposit, select the 
Direct Dep. checkbox for that 
employee. 9

Choose whether paychecks
should be printed from 
QuickBooks or written later
by hand.

10
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Intuit Payroll Services
Intuit offers a variety of 
payroll services to meet 
your needs. QuickBooks 
Basic Payroll includes tools 
and tax tables to help you 
efficiently run your payroll 
and pay your payroll taxes. 
(Basic Payroll does not 
include payroll tax forms.)

QuickBooks Enhanced 
Payroll adds state tax forms, 
tools for tracking workers’ 
compensation costs, and 
tools for easily calculating 
bonuses. Enhanced Payroll 
lets you to process payroll 
for up to three business 
entities (EINs). 

QuickBooks Enhanced 
Payroll for Accountants 
includes all of this, plus 
after-the-fact payroll, 
client-ready reports, and the 
ability to process payroll for 
up to 50 specific businesses. 

With QuickBooks Assisted 
Payroll, Intuit handles your 
tax payment and filings 
for you.

All QuickBooks payroll 
services offer direct deposit 
of employee paychecks for 
a small additional fee. For 
more information about 
payroll services, go to the 
Employees menu and click 
My Payroll Service.

Did You Know
Paying Employees
Paying employees is a big responsibility. You have to keep 
track of hours, salaries and wages, Social Security numbers 
and dependents, tax rates and forms, vacation and sick time, 
bonuses and advances, as well as company payments to 
government and private pension plans. QuickBooks provides 
several features and services to help you manage your own 
payroll quickly and easily.

Note: For information about your payroll options in QuickBooks, choose 
the Employees menu, choose My Payroll Service, and then choose 
Change Payroll Service Options.

To print paychecks:

➊ Choose the Employees menu, choose Pay Employees, and 
then specify whether you want to pay employees using 
Unscheduled Payroll (generally used to pay bonuses and 
off-cycle checks) or set up Payroll Schedules.

➋ Update the Pay Period Ends date and the Check Date 
values, as needed.

➌ Click the Bank Account drop-down arrow to choose the 
account that QuickBooks uses to record this transaction.

➍ Select the employees you want to pay by clicking in the 
column to the left of the employee’s name.

➎ Review the paycheck information in the Enter Payroll 
information window.

➏ To preview or modify a paycheck, click the employee’s 
name to open the Preview Paycheck window. Make any 
necessary changes and click Done.

➐ Click Continue.

➑ Review and verify the paycheck information in the Review 
and Create Paychecks window.

➒ If employees are set up for direct deposit, click the Direct 
Deposit checkbox next to each employee to be paid by 
direct deposit.

❿ In the Paycheck Options section, select whether the 
paychecks should be printed or handwritten.

⓫ Click Create Paychecks.

⓬ In the Confirmation and Next Steps window that 
appears, click Print Paychecks. Click Send Payroll to Intuit 
if you’re sending your payroll to Intuit for processing.
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Report Center: Getting there

Report Center: Finding your way around

Tabs organize your reports so
they’re easy to find (Standard,
Memorized, Favorites, and 
reports you’ve run recently).

Click a category to see the
reports in that category.

Click the Report Center icon to
open the Report Center.

Learn to manage, use, and make
the most of reports in the 
Learning Center.

View reports in different formats:
Carousel view (shown here), List
view, and Grid view.

Download reports and get FAQs
and tips from the Intuit
Community Reports Library.

Adjust the start 
and end dates.

Learn more about
the report.

Mark the report
as a favorite.

Display the report.
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Using Reports to see how your business 
is doing
One of QuickBooks’ most robust features is its ability to 
generate data-rich reports about your business. Everything you 
enter in QuickBooks can be found and generated into a report.

QuickBooks comes with dozens of prepared reports you can 
run, and you can download additional reports from the Intuit 
Community reports library at community.intuit.com/library/
reports.

The Learning Center helps you learn about QuickBooks reports 
and locate the ones that will give you the information you 
need. Once you’ve found a report, you can change its date 
range, customize the way it looks, print a copy of it, export it 
to Microsoft Excel, or display it on your screen.

To find and display the right report:

➊ Click the Report Center icon at the top of the QuickBooks 
window. The Standard tab lists the standard report 
categories. 

➋ Click a category on the left to see the reports in that 
category on the right.

➌ When you find the report you want, click its name to view 
the report.

• To learn more about the report, click the question mark 
icon .

• When viewing a report, you can also use the controls at 
the top of the page to modify, memorize, print, email, 
export and further customize your report: 

 

Tip:  From the QuickBooks Centers, get a quick 
snapshot of how your business is doing and the status 
of your relationships with customers, vendors, and 
employees. You can easily see all of your unpaid bills, 
all invoices your customers haven’t paid, and the 
detailed history of each customer and vendor. For 
more information about the QuickBooks Centers, refer 
to “QuickBooks Centers” on page 6 and the in-product 
Help.

Customizing a report 
QuickBooks provides many 
preset reports that focus on 
all aspects of your business 
finances.

However, you might want to 
change the way the data is 
displayed, or filter the report 
for specific information. To 
get the most out or your 
QuickBooks reports, you can:

•	Change the data range of 
a report

•	Change the scope of a 
report

•	Modify the appearance of 
a report (changing fonts 
or columns widths)

To learn how to get the most 
out of your reports, go to 
the Report Center and click 
the Learning Center button 
near the top of the window.

Did You Know
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How to Use Reports to Find the Information You Want
The QuickBooks Report Center describes all the available reports. Here are 10 common questions 
that people ask and the QuickBooks report you can use to find the answer.

To answer this question ... Use this report

How much money did my company make or lose over a specific period of 
time?

Profit & Loss 
Standard 
(in Company & 
Financial)

Which invoices or statement charges haven’t been paid and when are 
they due?

A/R Aging Detail 
(in Customers & 
Receivables)

How much does my company owe each vendor and are any payments 
overdue?

A/P Aging Detail 
(in Vendors & 
Payables)

What is the value of my company (its assets, liabilities, and equity), and 
where can I see the total balance for each type of account?

Balance Sheet 
Summary 
(in Company & 
Financial)

What is the recent activity in all my company’s accounts, with beginning 
and ending balances for each account?

General Ledger 
(in Accountant & 
Taxes)

What are the total sales for each customer and job?
Sales by Customer 
Summary 
(in Sales)

Which items and/or services bring in the most/least income?
Sales by Item 
Summary 
(in Sales)

What are my company’s total expenses for each vendor?

Expenses by Vendor 
Summary 
(in Company & 
Financial)

Where is the information I need for my federal income tax forms?

Income Tax Summary 
Income Tax Detail 
(in Accountant & 
Taxes)

For my company’s total sales, how much is taxable, at what rate, and how 
much sales tax is currently due to be paid?

Sales Tax Liability 
(in Vendors & 
Payables)
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Marking reports as favorites 
If you have favorite reports, you can mark them as favorites and add them to your Favorites 
tab. When you view a report, click the  to mark it as a favorite .

Memorizing a report for reuse
Whenever you change the settings for a report (modify it), you can memorize the report with 
the new settings and save it on the Memorized tab. Then, when you want to create a similar 
report, you can click the Memorized tab to find it.

Note: QuickBooks memorizes the report settings, not the data in the report. When you display a memorized 
report, it applies the settings you memorized, but displays the latest data. For example, if the report date is set 
for the period Last Month and you memorize the report in September but recall it in December, the recalled 
report will have data for November, not August.

To memorize a report:

➊ Click the Report Center icon at the top of the QuickBooks window.

➋ Open the report you want to modify and save.

➌ After you have customized a report, click Memorize at the top of the report.

➍ If you have changed an existing memorized report, indicate whether you want QuickBooks 
to replace the earlier report (under the same name) or create a new memorized report 
(under a new name).

➎ In the Memorize Report window, enter a title for the report.

➏ If you want to assign the report to a memorized report group, click the Save in Memorized 
Report Group checkbox and choose the group from the drop-down list. (You must already 
have the group set up on your Memorized Report List. You cannot create a new group 
here.)

➐ Click OK.

Tip:  When you create a report, you can change the way it looks (reformat it). You can 
change the fonts, change the header and footer, and resize the columns.

You can also move and sort the data that the report contains. For example, you can add 
or delete columns, sort by columns, move columns, change how numbers display, change 
how transactions sort, and change the subtotal groupings.

For more information about how to modify the look and content for a report, refer to the 
in-product Help.
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Getting started with Document Management

Document Management: 
Attach documents to your QuickBooks records

Once you link your company
file with the Document
Management service, click the 
Attach button to attach
one or more documents to
a transaction.

When you attach a document,
the paperclip turns green to
indicate there’s an attachment.

Click the Doc Center icon to
open the Doc Center.

Or click Company > Document 
Management > Learn About
Document Management.

Sign in to your Intuit Account.
If you don’t have one, you 
can create it.
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About Document Management
If you’ve ever wanted to attach documents to the records 
you create in QuickBooks, you can do it using the QuickBooks 
Document Management service.1 

The Document Management service lets you attach 
documents to your QuickBooks records and stay organized 
by keeping all of your uploaded documents in one central 
location. 

To use the Document Management service, sign up and 
choose the subscription that works best for you. (For details 
about subscriptions, follow the sign-up steps and get current 
pricing and subscription information.)

You can attach local files from your computer, files you’ve 
added to the Document Management inbox, and files from a 
scanner.  With the free account you can attach approximately 
1000 documents from local files from your computer, files 
you’ve added to the Document Management inbox, and files 
from a scanner.2

Note: If you use more than one company file, you must sign up each 
company file for the service.

To sign up:

➊ In your QuickBooks company file, choose Company > 
Document Management > Learn About Document 
Management.

➋ Click the Sign Me Up button.

➌ Follow the onscreen instructions to complete the sign-up 
process.

To attach documents to your QuickBooks records:

➊ Click the Attach button or paperclip icon in any 
QuickBooks record. 

➋ In the Attachments window, click the appropriate button 
(Local Files, Online Document Inbox, or Scanner) and 
locate the file to attach. 

➌ Select the file and click OK.

To view an attachment, click the green paperclip.

1. Internet access required for online services.
2. Scanner not included. Only TWAIN compliant scanners and Fujitsu 
Scansnap s300 supported. Maximum 100 MB per file. Total free stor-
age 100 MB or about 1000 two-page PDFs.

More than just attaching 
documents
The Document 
Management service gives 
you more than the ability 
to attach documents to 
your business transactions. 
It’s a service that lets you 
organize all of your business 
documents in one place. 

All of your important 
business documents are 
easy-to-find, backed up 
online, and simple to 
share with accountants, 
employees, and others. (You 
can even scan documents 
right in QuickBooks, so you’ll 
never lose them again.)

As easy as a paperclip, 
Document Management lets 
you save time by attaching 
any type of document — 
electronic or scanned files 
— to any customer, vendor, 
employee, account, items, or 
most transactions.

For more information about 
how to use the Document 
Management service, refer 
to the in-product Help.

Did You Know
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Other QuickBooks Services to help you manage your business
QuickBooks business solutions enable you to streamline management of your business and 
automate essential business activities. QuickBooks business solutions offer easy-to-use, tightly 
integrated products and services that will enable you to manage your business efficiently and 
with confidence. (Each service or solution sold separately.)

Intuit products and services include:

• QuickBooks Online Banking

• QuickBooks Bill Pay Service

• QuickBooks Deluxe Online Billing Service

• QuickBooks Remote Access

• QuickBooks Online Backup Service

• QuickBooks Merchant Account Service

• QuickBooks Technical Support Plan

• QuickBooks Checks and Supplies

• QuickBooks Shipping Manager

• QuickBooks Employee Organizer

• QuickBooks Basic Payroll

• QuickBooks Enhanced Payroll

• QuickBooks Assisted Payroll Service

• QuickBooks Point of Sale software or hardware

• QuickBooks Platinum Plus Business Mastercard

• QuickBooks Customer Manager Online

• QuickBooks Client Manager software

• Enhanced Payroll for Accountants

To learn more about these business solutions, go to the Help menu and click Add QuickBooks 
Services.
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Intuit Workplace App Center – Affordable applications to help 
your business
New in QuickBooks 2010, Intuit introduces Intuit Workplace Apps – web-based business 
applications that help you grow your business and work more efficiently.  In the QuickBooks 
navigation bar, click the App Center button to go to the Workplace App Center, where you can 
discover the right Workplace Apps to help solve your unique business needs.

Why try Intuit Workplace Apps?
•	 	Applications to suit a variety of business needs

From front office to back office, the Workplace App Center points you to applications that 
help solve your business challenge. Shop and browse the Workplace App Center’s key areas: 

Run My Business:  Need help with everyday tasks, like human resources or organizing your 
assets and finances? Make it easier to run your business by using applications that share 
payroll information with employees, automate expense reporting, survey your employees, 
find ways to make your business green, and more.

Manage My Work: Too much to do? Want to organize your work? Find applications to help 
you with project management, document management, and task management. Discover 
ways to collaborate more effectively, such as using web conferencing for meetings.

Grow and Manage My Customers: Worrying about customers? Customers are the lifeblood 
of any business – whether you’re trying to get more or effectively manage the ones you 
already have. Find applications to help with email marketing and postal campaigns, or try 
one that lets your customers book appointments online. Check out a contact management 
or sales management app to instantly share updated customer information among your 
employees. Optimize your driving routes with an app that organizes customers by location. 

Reduce My Costs: Who doesn’t want to save more? There are Workplace Apps that can 
help you save money and streamline your business.  Reduce your fax costs with an internet 
fax application that lets you fax by email (from work, home, or on the road). Or for small 
businesses, create a virtual phone system so you don’t have to invest in hardware and 
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maintain it. You can even help the environment with an application that analyzes your 
environmental footprint and makes suggestions for lowering expenses. 

The Workplace App Center has new applications available all the time. Visit often to see 
what’s new.1   

•  Affordable for small businesses 
Take advantage of free trials and flexible pricing as you begin using Workplace Apps. As your 
business grows, the applications grow with you; pay for additional users or features only as 
you need them. 

• Work where and when you need to  
Workplace Apps help you and your team work anytime, anywhere and let you securely access 
your business data. These affordable, scalable web-based applications give you the ability to 
streamline business operations, increase productivity, and save time. And on top of that, you 
eliminate double data entry, since these applications can sync with your QuickBooks.

• Conveniently use and manage your Workplace Apps 
Sign in once, in one location to access, view, and manage all of your Workplace Apps. 

• Your Data is Protected and Accessible 
Have confidence that your data transmissions are secure and you can access your data 
anytime. The Workplace infrastructure is the same data center that processed 18.7 million 
tax returns through TurboTax for tax year 2008. As you use a Workplace App, know that your 
QuickBooks financial data is on your desktop and on Intuit servers, protected and accessible. 

Find applications that are right for you
In the Workplace App Center, you can view online demos, get in-depth product information, 
including key features and customer reviews, and use free trials to determine which solutions 
are right for you before you purchase.   

Visit the Intuit Workplace App Center today by clicking the App Center button in QuickBooks, or 
go directly to  http://workplace.intuit.com.

1 The Workplace Apps described above may not be available at all times. Visit the Workplace App Center for 
the most up-to-date list of applications available.

http://workplace.intuit.com
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General Key

To start QuickBooks without a 
company file

Ctrl (while 
opening)

To suppress the desktop 
windows 
(at Open Company window)

Alt (while 
opening)

Display product information 
about your QuickBooks 
version

F2

Close active window Esc or Ctrl+F4

Record (when black border is 
around OK, Save and Close, 
Save and New, or Record)

Record (always) Ctrl + 

Dates Key

Next day + (plus key)

Previous day - (minus key)

Today T

First day of the Week W

Last day of the weeK K

First day of the Month M

Last day of the montH H

First day of the Year Y

Last day of the yeaR R

Date calendar Alt +  
(down arrow)

Editing Key

Edit transaction selected in 
register or lift Ctrl + E

Delete character to right of 
insertion point Del

Delete character to left of 
insertion point Backspace

Delete line from detail area Ctrl + Del

Insert line in detail area Ctrl + Ins

Cut selected characters Ctrl + X

Copy selected characters Ctrl + C

Paste cut or copied characters Ctrl + V

Increase check or other form 
number by one + (plus key)

Decrease check or other form 
number by - (minus key)

Undo changes made in field Ctrl + Z

Help Window Key

Display Help in context F1

Go to next Help topic Tab

Go to previous Help topic Shift + Tab 

Display selected topic

Keyboard Shortcuts
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Activity Key

Copy check transaction in 
register Ctrl + O

Create invoice Ctrl + I

Delete check, invoice, 
transaction, or item from list Ctrl + D

Find transaction Ctrl + F

Go to register of transfer 
account Ctrl + G

History of A/R or A/P 
transaction Ctrl + H

Memorize transaction or 
report Ctrl + M

New invoice, bill, check or list 
item in context Ctrl + N

Open account list Ctrl + A

Open Customer Center 
(Customers & Job list) Ctrl + J

Open Help for active window F1

Open list (for current drop-
down menu) Ctrl + L

Open memorized transaction 
list Ctrl + T

Open split transaction window 
in register Ctrl + R

Open transaction journal Ctrl + Y

Paste copied transaction  
in register Ctrl + V

Print Ctrl + P

QuickReport on transaction or 
list item Ctrl + Q

QuickZoom on report

Show list Ctrl + S

Use list item Ctrl + U

Write new check Ctrl + W

Moving around  
a window

Key

Next field Tab

Previous field Shift + Tab

Beginning of current field Home

End of current field End

Line below in detail area 
or on report Down arrow ( )

Line above in detail area 
or on report Up arrow ( )

Down one screen Page Down

Up one screen Page Up

Next word in field Ctrl + 

Previous word in field Ctrl + 

First item on list or 
previous month in register Ctrl + Page Up

Last item on list or next  
month in register Ctrl + Page Down

Close active window Esc or Ctrl + F4
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